# Table of Contents

## Introduction
- Document history
- Welcome
- Suite module overview
- Requirements
- Evaluation options
- Support
- Terms and Conditions

## Download and Installation
- Modularity
- Automated installation using the ProSimA320 Suite Installer
- Manual installation of the ProSimA320 Suite
- ProSimA320 Flight Model installation

## Configuration of ProSimA320 Suite Modules
- ProSimA320 System
  - ProSimA320 System overview
    - Config > Configuration
    - Config > Database
    - Help > Updates
  - Hardware Configuration
    - Drivers
    - Cockpit Concept
    - CPFlight
    - Direct support for joysticks
    - EHID (Cockpitsonic / UweSchneider)
    - Flight Deck Solution (FDS)
    - Flight Illusion
    - FSCockpit
    - FSUIPC
    - Flight Sim Center (FSC)
    - IOCP (Opencockpits)
    - Phidgets
    - PoKeys
    - Pololu
    - Skalarki

---

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
TRC 27
Hardware connection validation. 28
General network settings for ProSimA320 modules 29
ProSimA320 Display 30
Introduction 30
Module instances and directory names 30
Configuring the displays 31
ProSimA320 Audio 33
Introduction 33
Additional Sounds 34
ProSimA320 MCDU 36
Introduction 36
Module instances and directory names 37
Specific hardware connection 37
Non-specific MCDU hardware 37
ProSimA320 MCDU options 38
Screen layout for VGA / DVI connected MCDUs 39
ProSimA320 Hardware Connector 41
ProSimA320 IOS 42
Introduction 42
ProSimA320 IOS features 43
ProSimA320 Flight Model 43
Miscellaneous 44
Automatic startup for ProSimA320 modules 44
FSUIPC 44
Backend simulator settings 45
Introduction

This document is provided as a user manual to ProSimA320 and contains all relevant information to a speedy setup.

Document history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Author</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2 January 2017</td>
<td>S &amp; H</td>
<td>Initial release</td>
</tr>
</tbody>
</table>

Welcome

Thank you for your interest in ProSimA320. The ProSim-AR team have introduced the highest detail, designed from the ground up, to capture the essence of this aircraft. The team is passionate with the continuous development of ProSimA320 and is confident to set new standards that will exceed expectations within flight simulation.

Suite module overview

The ProSimA320 Suite consists of individual modules of which ProSimA320 System is the central component. The ProSimA320 System module interacts with your back-end simulator platform software (Microsoft® Flight Simulator™ 10, Lockheed Martin Prepar3D®) therefore, runs on the primary computer. Distribution of all other modules is possible across multiple computers within your simulator configuration.

- **ProSimA320 System**: Manages the simulation of aircraft systems, acts as a central network hub for all ProSimA320 Suite modules, interfaces with your hardware components, configured by graphical interfaces and features a webserver for the Instructor Operating Station (IOS).

- **ProSimA320 Display**: Generates all graphical elements such as Primary Flight Display (PFD) and Navigation Display (ND) on the Main Instrument Panels (MIP) Display Units (DU). Creates graphical representations of the different panels within the cockpit, can be used to check the state of switches / indicators and displays the panels also without hardware.

- **ProSimA320 MCDU**: The Master Control Display Unit (MCDU) controls the Flight Management System (FMS). This module provides possible connection of the MCDU in your cockpit or to display a graphical representation without hardware.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
ProSimA320 Audio: Provides genuine cockpit sounds independent from the environmental sound. Default sounds can be customised and new sound events can be added.

ProSimA320 Hardware Connector: Allows the connection of a part of the cockpit hardware components to a secondary computer.

ProSimA320 Flight Model: Provides realistic aircraft behaviour and a visual model with customisable livery.

ProSimA320 IOS: The Instructor Operating Station gives the controllability of the simulator by use of a web interface.

Requirements

Internet connection requirement:

- In order to initially activate and remain active, an internet connection is required for ProSimA320 System to connect to the ProSim-AR servers.

Software requirements:

- Microsoft® Windows™ 7, Windows™ 8 or Windows™ 10 operating system.
- Registered (paid) FSUIPC 4 by Peter Dowson, licensed via simMarket: http://secure.simmarket.com/pete-dowson-fsuipc4.phtml

Back-end simulator platforms supported:

- Microsoft® Flight Simulator™ version 10 (FSX).
- Lockheed Martin Prepar3D® version 1.x, 2.x and 3.x.

Minimum system requirements:

- For the primary computer please refer to Lockheed Martin Prepar3D® system requirements: http://www.prepar3d.com/system-requirements/
- ProSimA320 System diskspace requirement 500MB.
- For secondary computers no specific hardware requirements apply.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Evaluation options

Evaluation of the ProSimA320 Suite is important for your satisfaction prior to obtaining a user license. To obtain your free trial, two options are offered:

- Free limited, extensive 30 minute periods
- Free 30 day trial

To obtain either option, simply download the ProSimA320 Suite and install the software as described in the next paragraph. The ProSimA320 Suite is safe to use and will not affect any currently installed software.

By selecting the 30 minute evaluation option on startup of ProSimA320 System, this provides instant access without entering a license key. Following this 30 minute period, for further evaluation select again the 30 minute evaluation option.

For the free 30 day trial, a license key will be provided within 24 hours following completion of the request form following this link:

http://prosim-ar.com/free-prosim320-trial/

After completion of your 30 minute evaluation or 30 day trial, obtaining a ProSimA320 user license will not affect configurations made during this period.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Support

For technical information or assistance, multiple options are available.

ProSim-AR Software User Manuals
In the first instance please refer to the user manuals. These contain technical descriptions of ProSimA320 work and what is the setup process.

ProSim-AR Forum
The ProSim-AR Forum is a facility available 24 hours a day and serves as a platform for users to interact, share knowledge, offer support and information.

Email Support
As a final option you have the opportunity to send us your request by email to support@prosim-ar.com.

When sending an email make sure to provide the following information:
- Explanation of the issue. What was expected to happen and what did actually happen. Use screenshots or videos to clarify.
- When did the issue first occur, after a software / hardware update, or during flight.
- Always attach the log.txt, crashlog.txt and config.xml files from the ProSimA320 System directory.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Terms and Conditions

The software you are about to download, install and/or use is subject to the intellectual property rights of ProSim Aviation Research B.V. and the applicable Terms and Conditions stated below. Your downloading and/or installation and/or use of the software indicates your acceptance thereof.

Provided you have not yet obtained a user licence from ProSim Aviation Research B.V. your use is restricted to limited use for evaluation purposes only and strictly for non-commercial use. Non-commercial use means private home use only.

To obtain a licence for non-commercial use visit the web shop at http://www.prosim-ar.com/shop/

To obtain a licence for other than non-commercial use please contact ProSim Aviation Research B.V., Rotterdamseweg 388D, 2629 HG Delft, The Netherlands, www.prosim-ar.com, info@prosim-ar.com. Phone +31-(0)858770808, Fax +31-(0)858770281.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These Terms and Conditions have been filed with the Chamber of Commerce in the Netherlands under number 54069645.

ProSim Software Terms & Conditions for non-commercial use
http://prosim-ar.com/terms_and_conditions/ProSim-AR_Software_Terms_and_Conditions_non-commercial_use.pdf

ProSim Software Terms & Conditions for commercial use
http://prosim-ar.com/terms_and_conditions/ProSim-AR_Software_Terms_and_Conditions_commercial_use.pdf

The information contained in this document is for general information purposes only. While we endeavour to keep the information up to date and correct, we make no representations or warranties of any kind, express or implied, about the completeness, accuracy, reliability, suitability or availability with respect to the information contained in this document. Any reliance you place on such information is therefore strictly at your own risk.

In no event will we be liable for any loss arising out of, or in connection to, the use of this document.

You may not, except with our express written permission, distribute or commercially exploit the content. Nor may you transmit it or store it in any other website or other form of electronic retrieval system.
Download and Installation

Modularity

The ProSimA320 Suite is modular and for performance reasons may be spread across one or multiple computers within one simulation setup.

The ProSimA320 System module may only run once per simulation setup. This must be installed on the computer where Lockheed Martin Prepar3D® is running on. In multi computer simulation setups this computer is referred to as the primary computer.

The ProSimA320 Display, ProSimA320 MCDU, ProSimA320 Audio and ProSimA320 Hardware Connector modules may run multiple instances within one simulation setup, either on the single primary computer or across multiple secondary computers.
Automated installation using the ProSimA320 Suite Installer

The ProSimA320 Suite installer provides step-by-step guidance to install the individual ProSimA320 modules.


All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Description of the different options offered:

- **ProSimA320 for primary (main) computer:**
  When selecting this option the following modules will be installed:
  - ProSimA320 System
  - ProSimA320 Display
  - ProSimA320 MCDU
  - ProSimA320 Audio

- **ProSimA320 for secondary (client) computers:**
  When selecting this option the following modules will be installed:
  - ProSimA320 Display
  - ProSimA320 MCDU
  - ProSimA320 Audio
  - ProSimA320 HardwareConnector

- **ProSimA320 additional modules options**
  The additional modules can be installed on the primary computer or secondary computers after the initial primary or secondary computer installation has completed. After installing a additional module a directory name change is required. By default the additional modules will contain an extra "_2" name, adjust the name to the folder function, for example "ProSimA320 Display Lower ECAM".

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Manual installation of the ProSimA320 Suite

The following text is in regard to the manual installation of the ProSimA320 Suite without making use of the ProSimA320 Suite installer.

1. Download the ProSimA320 suite .ZIP file from the downloads page of the ProSim-AR website: http://prosim-ar.com/downloads/

2. The filename of the downloaded .ZIP archive contains the following format: ProSimA320-1.00.zip. Extract this .ZIP archive, for instance in the root of your hard drive: C:\ProSimA320-1.00\

3. Open the directory where the archive has been extracted to, which contains a number of .ZIP files. Extract these files into separate subdirectories. Example directory structure:

4. If a secondary computer is being used, copy the previously extracted module directory to that computer.

5. When multiple instances of a module on the same computer are required, copy the existing module directory to a new directory under a different name. As an example, each physical monitor in the MIP requires a separate instance of the module ProSimA320 Display to run. A typical directory structure would look like this:

   C:\ProSimA320-1.00\ProSimA320 Display Captain\n   C:\ProSimA320-1.00\ProSimA320 Display FO\n
All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
ProSimA320 Flight Model installation

The ProSimA320 Flight Model is delivered via the version manager within ProSimA320 System. The version manager is accessed by clicking Help > Updates. The Flight Model is listed under the ‘add-ons’ tab.

For 30 minute or 30 day evaluations only the evaluation version of the flight model is available. The Evaluation flight model is a less realistic flight model in terms of behaviour for the purpose of testing system logic and hardware connectivity.

After purchasing a user license of the ProSimA320 Suite the normal realistic ProSimA320 Flight Model is available.

Click ‘download’ for version selected. After the download has completed, execute the program and follow the installer instructions.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Configuration of ProSimA320 Suite Modules

ProSimA320 System

In the cockpit, pilots interact with an aircraft in various ways. There are switches, dials and levers to interact with the aircraft and there are indicators and gauges to read back states. All of these elements are represented in ProSimA320 System. For the software to operate correctly, ProSimA320 System needs to know exactly how these elements relate to your specific cockpit hardware.

Configuring ProSimA320 System is the process of assigning each of these elements to the physical switches, indicators, levers and dials that you have in your cockpit.

ProSimA320 System overview

Double click the file prosima320.exe from the C:\ProSimA320-1.00\prosima320\ directory on the primary computer for the ProSimA320 System module to start. During initial startup of ProSimA320 System, firewall warnings may be displayed. ProSimA320 System starts a built in web server and connects to the ProSim-AR servers, this is a normal procedure.

If no license key has been entered previously ProSimA320 System will display a license key input screen on startup. Enter a valid license key or select 30 minutes free trial and press OK to continue. Internet connection is required for this step.

Read Terms and Conditions as displayed. Agree to continue or abandon use.

First the splash screen appears for a couple of seconds after which the ProSimA320 System Interface is displayed
The ProSimA320 System Interface always displays a horizontal top navigation with the items “File”, “Config” and “Help”.

Below is a horizontal navigation bar dividing the screen in tabs. The main tab displays an overview of connected cockpit hardware and software, the other tabs display the current state of cockpit switches, indicators, gauges, gates, etc. These tabs are not used for making configuration changes, they are only used to display the current state of elements or to change the value of a switch in the software if no hardware switch for that particular function is connected.

While running Lockheed Martin Prepar3D® verify that the ‘simulator connection’ on the main tab states connected. If not check FSUIPC installation.

The following screens are necessary to take further action.

Config > Configuration

Through the Config top navigation option the configuration screen is accessed. The configuration screen contains four tabs:

1. Main - Used for general configuration settings. Recommended after initial setup.
2. Drivers - Used to enable drivers for cockpit hardware.
3. Combined config - Used to assign hardware indicators, gauges and switches to software functions.
4. Switch types - Used to override the correct switch type when cockpit hardware has incorrect switch types installed. A latched switch maintains the state set, a momentary switch returns to the original state.
ProSimA320 System requires the installation of navigational data in order to function correctly.

Start by downloading the Navigraph database package from the download page of the ProSim-AR website and install. 
http://prosim-ar.com/downloads/

Open the config > database screen in ProSimA320 System. Verify that the Navigraph database is loaded, if not, reinstall.

In the terrain data section click download to start and install. Once installed, verify that the terrain database is available, if not, reinstall.

Select the path to the installation directory from your back-end simulator (Lockheed Martin Prepar3D®) under ‘Scenery Database’ to start extracting scenery navigation data from Prepar3D® to ProSimA320 System. Remember to repeat this step after making changes to your installed scenery.
Help > Updates

Click Help > Updates to open the ProSimA320 version manager which displays the current installed version number and the expiry date of the update subscription and contains 3 tabs:

- Releases - Used to download and install regular ProSimA320 updates.
- Add ons - Used to download ProSimA320 Flight Model updates and other add-ons.
- Beta releases - Used to download and install beta releases.

ProSimA320 System will notify when new releases become available. In order to install a new version, click install in the ProSimA320 version manager.

In between releases, the ProSim-AR team constantly creates beta releases for testing purposes. Beta releases may be installed however can contain untested functionality. To receive notifications for new beta releases check the box ‘monitor beta releases’ in the config > configuration > main screen.

Hardware Configuration

Cockpit hardware can be divided into two groups:

1. Specific hardware
   Specific hardware are modules that can tell ProSimA320 exactly what the state of specific switches / function is. These are usually plug and play panels like radios and FCUs. This hardware requires little configuration.
   Examples are all Skalarki, FSCockpit, CPflight, Cockpitsonic components as well as some FDS cockpit modules.
2. Generic hardware

Generic hardware are parts that provide a set of input and output signals which don't have a specific function. These boards are usually generic I/O boards. With this hardware, ProSimA320 needs to be configured in detail. Examples are FDS SYS boards, Phidgets boards, OpenCockpits hardware and joystick cards.

Drivers

Each brand (or category in case of Directinput) of hardware that is supported in ProSimA320 requires a specific hardware driver. All of these drivers are built in ProSimA320 System. Before hardware can be configured, all of the required drivers need to be enabled in ProSimA320 System.
At the time of writing of this manual the following hardware brands are supported:

Cockpit Concept
CPFlight
Direct support for joysticks
EHID (Cockpitsonic / UweSchneider)
FDS (Flightdeck Solutions)
Flight Illusion
FSCockpit
FSUIPC
IOCP (Opencockpits)
Phidgets
PoKeys
Pololu
Skalarki
TRC

Cockpit Concept

CPFlight
All CPFlight hardware is specific hardware, so only the driver needs to be selected. CPFlight is using a USB COM port to communicate with ProSimA320 System. Connect the USB device to the primary computer, do not install any CPFlight provided software. Open ProSimA320 System > Config > Configuration > Drivers. Select the appropriate COM port in the CPFlight driver tab. Accept the change in ProSimA320 System by selecting OK. Restart ProSimA320 System and validate the configured hardware.

Direct support for joysticks
Joystick input is a generic hardware device which requires to configure all IO element manually. Joysticks should be listed in the Windows Game controllers. (Windows search: game controller). Most joysticks interfaces provide a combination of analog input and switches. For flight controls (analog inputs) the first step is to calibrate the joystick in Windows Game Controller, select properties > settings > calibrate. Follow the steps described in the calibration tool. When the Joystick is calibrated in Windows open ProSimA320 System and open the driver tab, ProSimA320 System > Config > Configuration > Drivers and enable the direct input for joystick. Select OK and restart ProSimA320 System. The next step is to open the Combined Config tab: ProSimA320 System > Config > Configuration > Combine Config. You can here assign switches and axis (axis = potentiometer or analog input)
Assigning switches:
Search for the appropriate switch function in the combine config search. Move the switch, in the upper part of the configuration screen the last input should be listed (latest input), select “A” to assign the switch to the function. Make sure to only assign values 1, (listed in the latest input) do never assign value 0, also do not assign IDs double.

Assigning axis:
Search for the appropriate axis in the combine config search. When the correct axis is visible in the “latest input” select “A” to assign the function of the axis. Next step is to calibrate the min, max and center position. Move the hardware axis left, in the ProSimA320 System Combined Config a green indication is moving, select min, max or center depending of the type of axis function.

EHID (Cockpitsonic / UweSchneider)
Cockpitsonic should be configured in ProSimA320 as a specific hardware device. To connect Cockpitsonic hardware the first step is to download EHID and the A320 config package from the Uwe Schneider website: http://www.uweschneider.de/en/downloads.php
An EHID license is required which can be obtained from Uwe Schneider: http://www.uweschneider.de/en/EHID_endusers.php

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
When EHID, the A320 XML and a valid EHID license are installed, the Cockpitsonic hardware should be listed in the EHID software.
Open the driver tab in ProSimA320 System, ProSimA320 System > Config > Configuration > Drivers. Navigate to EHID Server and enter the IP address and port number of your EHID server.

All Cockpitsonic hardware is connected to the EHID software which communicates with ProSimA320 System. An exception is the MCDU, this device should be configured in ProSimA320 MCDU:

1. Start the hardware MCDU and select menu on the device.
2. On the hardware MCDU you should check or adjust the IP address used.
3. Open the EHID.INI.
4. Enter the IP address(es) for the MCDU(s).
5. The MCDU should be listed in the EHID software.
6. Open ProSimA320 MCDU, right mouse click and select Config.
7. Enter in the EHID Server IP address.
8. Only one ProSimA320 MCDU should be configured, in the option tab select the MCDU role and select “stand alone device”.

Flight Deck Solution (FDS)
FDS provide specific hardware and generic hardware. For the specific hardware only the driver needs to be selected in ProSimA320 System driver tab, ProSimA320 System > Config > Configuration > Drivers.

An advanced tab is available to specify all COM/NAV/ADF panels. When opening the advanced tab the hardware panel shows a unique number. Match the hardware number in the advanced tab, close the configuration by selecting Ok.

Throttle quadrant should be configured in ProSimA320 System Combined Config, where Trim DC motor, the analog throttle levers and the switches are assigned. In the combine configuration search for “throttle” to assign the throttle levers and switches. Search for “trim” to assign the trim motor, the DC motor should be configured as a “numerical” output.

The overhead panel is a generic hardware device, in ProSimA320 System combined configuration all switches and indicators are assigned. Use the search option in the combined config to search for the specific switches and indicators.

Analog SYS1 cards can be used as lever, DU brightness or other analog functions. The first step is to calibrate the Joystick in Windows Game Controller, select properties > settings > calibrate. Follow the steps described in the calibration tool. Next step is to calibrate the function of the axis, search in the combine config the specific function for the axis. In the Combined Config all axis assignments are listed as analog inputs.
The MCDUs feature VGA displays and a specific IO board. Start ProSimA320 MCDU and open Config by right clicking the screen. On the Drivers tab, in the ‘Tekworx/FDS MCDUs’ section select the COM port and check the “enable” box. Restart ProSimA320 MCDU, while restarting a relay click from the MCDU should be heard. When the MCDU screen is turned on, an additional monitor will be listed in the Windows display settings. In the ProSimA320 MCDU configuration Options tab deselect the options “show frame” and “show border”. Move the graphical ProSimA320 MCDU across the Windows desktop to the hardware MCDU monitor. Then select ‘start full screen’ in the ProSimA320 MCDU Options tab.

Possibly the display is not aligned with the hardware line select switches left and right. To adjust the display lines use the “Line setup mode”, ProSimA320 MCDU > right mouse click > Line setup mode. In the Screen Layout tab a definition is given of the MCDU keys when using line setup mode.

Last step is to assign the MCDU role, open ProSimA320 MCDU and select right mouse click configuration. In the configuration you should assign the MCDU role to either captain or first officer.

Backlighting
Most hardware FDS panels feature backlighting without a relay. In order to simulate the aircraft power management a relay board can be used. Currently the Phidgets relay board is the only supported relay hardware in ProSimA320 System: [http://www.phidgets.com/products.php?category=9&product_id=1014_2](http://www.phidgets.com/products.php?category=9&product_id=1014_2)

FDS makes use of a 5 Volt system for the backlighting in combination of light bulbs, therefore care should be taken not to overload the maximum amperage on one relay card or channel.

Connect the backlighting board to the relay board, Phidgets requires software to run together with ProSimA320 System: [http://www.phidgets.com/docs/Operating_System_Support](http://www.phidgets.com/docs/Operating_System_Support)

When the Phidgets software is running open ProSimA320 System and select the Phidgets driver, ProSimA320 System > Config > Configuration > Drivers > Phidget. Restart ProSimA320 System and open the Combined Config tab, search for the gate called “pedestal backlight” and select it.

Flight Illusion
The flight illusion hardware can be used for the standby gauges Standby Attitude bank, Standby Attitude pitch and Wet Compass.

Assign the Flight Illusion driver in ProSimA320 System Driver.
ProSimA320 System > config > configuration > Driver > Flight Illusion
FSCockpit

All FSCockpit hardware is specific hardware. Connect the USB devices to the primary computer, do not install any FSCockpit provided software.

In ProSimA320 open the Config > Configuration > Drivers tab. Select the FSCockpit driver and close the configuration by selecting ‘OK’. ProSimA320 System will automatically restart.

On the ProSimA320 System main screen the connected FSCockpit devices are displayed.

In order to configure the throttle quadrant, open the Combined Config:
- Search for ‘throttle’ and ‘elevator trim’.
- Only the analog levers and the trim motor should be configured.
- Assign throttle lever 1 and 2, make sure to check all the detends. A null zone can be required on the different detent positions.
- The trim positions require configuration, use the elevator trim axis to assign the analog input.

FSUIPC

FSUIPC offsets are available for inputs and outputs. The FSUIPC input and output can be configured in the FSUIPC tab in P3D or FSX additional tab. In the first column, select the type of the offset to use. The second column has a different meaning for inputs and outputs.

ProSim supports three types of FSUIPC addresses:

- Normal offsets: these are normal whole FSUIPC offsets.
- Bit offsets: these are specific bits within an FSUIPC offsets.
- Value offsets: these are specific values of an FSUIPC offsets.

Inputs:
Normal offset: the system will test if the offset is zero or nonzero. To use normal offsets, just enter the offset in hexadecimal (e.g. 0x5642).
Bit offsets: the system will test if a certain bit in the offset value is set. Enter the offset in hexadecimal, followed by a ‘.’ and the bit number, starting from 0. For example, to test the fourth bit in offset 0x5642, enter "0x5642.3". The input is active when the bit is set.
Bit toggle: the system will test if a certain bit in the data is changed. Enter the offset in hexadecimal, followed by a ‘.’ and the bit number, starting from 0 and add a ‘T’. For example, to test changes in the fourth bit in offset 0x5642, enter "0x5642.3T". The input is active for one second when the bit is changed.
Bit clear: the system will test if a certain bit in the data is set. After reading this bit, it resets this bit to 0. Enter the offset in hexadecimal, followed by a ‘.’ and the bit number, starting from 0 and add a ‘C’. For example, to test changes in the fourth bit in offset 0x5642, enter "0x5642.3C". The input is active for a single read and the bit is reset by ProSimA320 system after reading it.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
Value offsets: the system will test if the offset contains a specific number. Enter the offset in hexadecimal, followed by a '=' and the value to test for. For example, to test if offset 0x5610 is 2, enter "0x5610 = 2".

Outputs:
Normal offsets: For lights, a "0" will be written for "off", a "1" for "normal brightness" and a "2" will be written for "bright". Gates write a "0" for "off" and a "1" for "on".

Bit offsets: The indicated bit will be turned on or off, depending on the state of the output.

Value offsets: If the state of the output is on, the specified value is written to the offset. If it is off, "0" will be written.

Flight Sim Center (FSC)
At the time of writing of this manual the only component from FSC interfaced is the MCDU. The hardware MCDU is a specific hardware device, so only the connection to the device should be configured. When using this MCDU it is advised to run ProSimA320 MCDU on the primary computer.

1. Open ProSimA320 MCDU.
2. The FSC MCDU is a ethernet device which requires a static IP address.
3. Power the FSC MCDU and directly select “menu” and adjust the IP address to match your network.
4. In ProSimA320 MCDU right mouse click and select config.
5. Select the Drivers tab and and enter the MCDU's IP address in the FSC MCDU field.
6. Click “OK” and restart the ProSimA320 MCDU module.

IOCP (Opencockpits)
At the time of writing of this manual a new SIOC driver is in development, expected in Q1 2017. Pending this new interfacing the current / old way of interfacing should be used.

SIOC is the Opencockpits scripting language. It uses variables for communications. To use a SIOC variable within ProSimA320, in the SIOC script select “IOCP” in the first column. Enter the number of the variable in the second column.

Architecture
There are various panels, IO cards and other hardware available from Opencockpits. This hardware is usually connected to the computer with a standard USB connector. All Opencockpits hardware uses the Opencockpits SIOC program to drive the hardware. ProSimA320 in turn, talks with the SIOC program. Generic lights and switches are handled by ProSimA320.

SIOC
The SIOC program can be downloaded from the Opencockpits website. SIOC contains a scripted language which can be used to write SIOC scripts. A SIOC script is a script that tells SIOC what to do with the buttons, knobs and indicators of the connected hardware. SIOC scripts consist of...
numbered variables and optional codes. The numbered variables are the storage of SIOC and contain all the data that is transmitted between SIOC and its connected hardware. Whenever a ProSimA320 module communicates with SIOC, it does so by sending and receiving the contents of the numbered variables. In ProSimA320 inputs and outputs can be assigned to variables by selection “IOCP” and entering a variable number.

Follow these steps to enable IO cards in ProSimA320:

1. Download and install the SIOC software.
2. Run the SIOC program.
3. Configure ProSimA320 System to connect to SIOC by opening the configuration screen.
   In the field for “IOCP Server”, enter the IP address and port of the SIOC server. This information is presented in the SIOC software.
4. Press OK.
5. Assign the SIOC variables that ProSimA320 System should use for input and/or output.
   This is done in the configuration screen. In the first dropdown “IOCP” should be selected and in the textbox next to it, a variable number should be used. ProSimA320 System communicates with SIOC by using these variable numbers. What SIOC should do with these numbers is up to the SIOC script that is used. Any number may chosen, as long as it is unique.
6. Create the SIOC script. To help creating your SIOC script, ProSimA320 System is able to create a stub script. This script lists all the configured variables in ProSimA320 System with a standard SIOC line. These SIOC lines should be edited in a text editor to set the correct physical ports on the boards that should be used. The subscript is available from the ProSimA320 instructor station. While ProSimA320 System is running, open a web browser and use the following URL: http://localhost:8080/sioc
7. After the SIOC script has been edited with the correct port numbers, compile it with the SIOC program. To do this, press the CONFIG button in the main SIOC screen. Next, from the Compiler Menu, select “Files” and select the SIOC script that has been edited. The second line should be filled in with required output file. This file usually has an .ssi extension. Next, close the window and press the “Compiler” button.
8. Configure SIOC to run the script. This can be done by editing the sioc.ini file.
9. Restart SIOC to complete the process.

Phidgets

The following Phidgets product are supported:

- 1012_2
- 1032_0
- 1014_2
- 1065_0
- 1066_1
- 1061_1

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
• 1203_2

Phidget cards are non specific card therefore all input and output requires manual configuration. Phidgets requires separate software to connect to ProSimA320 System. Download and install the Phidget software from the Phidgets website: [http://www.phidgets.com/docs/Operating_System_Support](http://www.phidgets.com/docs/Operating_System_Support)

Activate the IO element and define the function of the input in the Phidget software per hardware device.
Open ProSimA320 System and enable the driver in the ProSimA320 System Drivers tab. Depending the hardware device all input and output should be configured in the Combined Config, ProSimA320 System > Config > Configuration > Combine config. Use the search option to find the specific function to map.

PoKeys

PoKeys cards are non specific card therefore all input and output require manual configuration. PoKeys requires separate software to connect to ProSimA320 System. Download and install the PoKeys software from the PoLabs website: [https://www.poscope.com/downloads/](https://www.poscope.com/downloads/)

Select the PoKeys driver, ProSimA320 System > Config > Configuration > Drivers > PoKeys. A advanced setting page is available to fine tune the use of the device:
Autoconfigure
- PoKeys cards can have multiple configurations (digital / analog input, digital / analog output) per port.
- When enabled it will automatically configure each I/O port of the PoKeys card based on the configuration element selected. Otherwise it would be required to use the PoKeys software to previously configure PoKesy I/O ports.

USB cards, Fast Interface
- If enabled will use the BULK USB instead of a HID device. A specific driver from PoKeys is required.

Ethernet cards
- Background processing of ethernet PoKeys cards is available to prevent network delay from affecting ProSimA320 performance. Leave this off unless experiencing performance degradation in the PoKeys driver.
- UDP mode, Use UDP protocol instead of TCP. UDP is faster than TCP but less reliable as there are no data integrity checks.

Poller Enabled
- The poller is the automatic detection of PoKeys USB cards.
- If disabled, ProSimA320 will detect cards only during start up. If a PoKeys card is removed / added after prosim is running, ProSimA320 will not detect it.

Log
- Enabled the PoKeys library log entries to be available in ProSim Log to help debug any pokeys related issue.

Pololu
Product IDs 1393 and 1352 are supported.

Skalarki
Skalarki hardware is specific, a separate program, the Skalarki Profiler, is used to connect the hardware to ProSimA320 System.
1. Download the latest Skalarki Profiler from the Skalarki website
   http://skalarki-electronics.eu/
2. Install and run the Skalarki profiler.
3. Open settings:
   ● Select ProSimA320 as ‘aircraft developer’.
   ● All connected modules should be selected in the different tabs.
4. In the Skalarki Profiler main screen select ‘start SDK mode’.
5. Open ProSimA320 System and select the driver tab, ProSimA320 System > Config > Configuration > Drivers.
6. Select the Skalarki hardware support and enter the IP address of the computer running the Skalarki Profiler.
   ● If the Profiler runs on the primary computer enter the localhost address 127.0.0.1.
   ● If multiple Profiler instances are executed on multiple computers use ‘+’ and enter additional IP addresses.
7. When the driver is selected close the configuration by selecting ‘OK’ and restart ProSimA320 System.
8. When ProSimA320 System restarted the IO should be listed in the main screen.

TRC
At the time of writing of this manual only the wet compass is supported. To install the wet compass follow this procedure:

- Open ProSimA320 System.
- Select the TRC driver:
  ProSimA320 System > Config > Configuration > Drivers > TRC.
- Restart ProSimA320 System and connect the USB cable.
- ProSimA320 System main screen now comes up with a message to first calibrate the device using TRC software.
- Close ProSimA320 System.
- Download this TRC software and and install it
  make sure to install the software in the default directory otherwise it won’t work.
  http://www.simkits.nl/downloads/software/TRCUSBFsLink21.zip
- Start the calibration software, select trc_wc_calibration.
Go through all calibration steps, when asked about the hardware light regulation selection please choose “none”.

- Start ProSimA320 System
  The TRC driver in ProSimA320 System hardware box (main screen) will no longer show the “calibration error message”.

Hardware connection validation.

ProSimA320 offers multiple ways to validate if hardware inputs and outputs are configured correctly:

- Input Debugger
- ProSimA320 Display
- ProSimA320 System

On the ProSimA320 System main screen all IO elements configured should be listed. If any connected hardware component is not listed the driver settings, configuration, power settings and USB settings should be checked.

In order to validate the switches open the Input Debugger, ProSimA320 System > Help > Input Debugger. Clear the log and toggle the hardware switch, in the Input Debugger a switch input should be listed including the mapped function of the switch. If the switch input does not show in the Input Debugger the switch is not recognized in ProSimA320 System.
Indicators can be validated by using the ProSimA320 System tabs. Next to the main tab all different functions of the aircraft are listed in different tabs. In order to validate the indicator selected in one of the mentioned tabs, scroll down to the indicator list and select the “off” indication. When selecting the indicator the state is changed to ON which should also be reflected on the connected hardware.

All connected hardware can also be validated by using ProSimA320 Display. When selecting the different displays, for example the overhead display, the software panel should be a direct mirror of the hardware state. When switching the hardware state the should mirror the software state.

General network settings for ProSimA320 modules

If a ProSimA320 client module (all modules other than ProSimA320 System) is executed on the primary computer then no network settings are required. When running a ProSimA320 client module on a secondary computer it is required to set the IP address of the primary computer in the client module configuration screen.

It is required for all computers to be in the same IP range. The first three segments of the IP address should be the same, for instance: 192.168.0.XXX

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
In order to lookup the IP address on a computer open a command shell (run CMD) and enter ipconfig, look for the IPv4 address. Changing an IP address is done in the Windows network settings.

When a client module is configured correctly, right clicking on it should show a green status saying “server connection: connected”.

ProSimA320 Display

Introduction

ProSimA320 Display is the module that generates images on the MIP DUs for example the Primary Flight Display or Navigation Display. It can also be used to view graphical representations of hardware panels as well as standby instruments, overhead displays and pedestal displays.

Module instances and directory names

Per physical monitor in the simulator one separate instance of ProSimA320 Display is used. The separate instances should be executed from separate directories. Therefore copy the ProSimA320 Display directory as often as needed and give it a descriptive name, for instance:

\ProSimA320\ProSimA320-Display-CPT
\ProSimA320\ProSimA320-Display-FO
\ProSimA320\ProSimA320-Display-ECAM

Only change the directory name, do not change the name of the executable.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
On first start of each ProSimA320 Display module instance first enter the IP address of the primary computer in the configuration.

Configuring the displays

Open ProSimA320 Display, by default a black screen is displayed. For the ease of configuration it’s recommended to select Ground Power in the IOS and set the overhead Ground Power switch to on. If no hardware overhead is present use ProSimA320 Display > right mouse click > display > overhead and select ground power switch. Close the display overhead by right mouse click > close overhead.

When ground power is selected the captain PFD and ND will be visible. Hit F12 to enter the display setup mode. The display setup mode is only used during configuration, not for normal operation. In display setup mode, a blue background colour is shown, when selecting F12 once more display background colour changes back to black.
In display setup mode screen elements can be added or removed, they can be moved by dragging with the mouse, the size is adjusted by using the mouse scroll wheel or numeric + and - keys. Remove a displayed element by right clicking and selecting the ‘remove ...(name of the display)’. Adding a display element is done by select right mouse click > displays. When the display is correctly configured close the configuration mode by selecting F12 again in order to save the settings.

Several configuration options are available, mainly with regard to performance, open ProSimA320 Display > right mouse click and select config.

- General Options are options for higher graphical quality, these can be selected based on the computer performance.
- Standby instruments are offered with or without frames around them and as photorealistic.
- Interface stay on top is used to keep the ProSimA320 user interface visible.
- Tuning allows to adjust the data rate and frame rates. Default data rate is 10, default frame rate is 30.
- Multicore optimization is used to increase the display performance.
- Show load in title bar is used to constantly display the display load parameters in the Windows title bar.
- ‘Allow remote computer shutdown’ is used to remotely shut the computer down using the IOS.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
When closing ProSimA320 Display automatically all setting is saved. The information is all stored in a file called config.xml.

![Configuration](image)

**ProSimA320 Audio**

**Introduction**

The ProSimA320 Audio module is managing all in cockpit sounds. Environmental audio for example engine sound, are created by the back end simulator and the ProSimA320 Flight Model.

The first step is to configure the network settings.

When the ProSimA320 Audio module is connected you can use the available cockpit audio sounds. The different sounds can be turned on or off and the individual volume can be adjusted. For audio channel separation multiple instances of ProSimA320 Audio can be used across multiple computers. No more than one instance of ProSimA320 Audio is used per computer. Volume control can be adjusted by changing the volume value, default 100(%) is selected. To lower the specific sound change a different value, for example 70%.
Additional Sounds

Sounds are added following these steps:

1. Add the audio file to ProSimA320 System.
   - Open ProSimA320 System and select the Audio Addons option:
     ProSimA320 System > config > Audio Addons
   - It is recommended to create a specific folder to store the addon audio files.
   - Create a unique name, select the audio file source, when required add a fade in and fade out sound, select if the sound should be played once or continuously and if required select the auto fade option.
   - For this example the addon sound is saved as “Test Audio”.
   - Restart ProSimA320 System.

   ![Audio Addons window]

2. Select a function for the addon audio.
   - Open ProSimA320 System > Config > Configuration > Combined Config
   - Search for the addon audio “Audio Addon”
- Select [Gate].
- Select the appropriate situation.
- Restart ProSimA320 System.

3. Test the sound in ProSimA320 Audio
   - Open ProSimA320 Audio.
   - The newly added sound is visible in the list.
ProSimA320 MCDU

Introduction

The ProSimA320 MCDU module simulates a full MCDU / FMS system, including an accurate LNAV / VNAV implementation. The configuration of MCDU hardware also is done using the ProSimA320 MCDU module.
Module instances and directory names

Multiple hardware MCDUs can be configured to work independently from each other. For every physical MCDU one instance of ProSimA320 MCDU is required to run. Therefore copy the ProSimA320 MCDU directory as often as needed and give it a descriptive name, for instance:

\ProSimA320 MCDU Captain
\ProSimA320 MCDU FO

Next thing is to configure the network settings for the ProSimA320 MCDU module to connect to ProSimA320 System.

Specific hardware connection

At the time of writing the following specific MCDUs are supported, follow the links for setup instructions:

- Flight Deck Solution (FDS)
- CockpitSonic
- Flight Simulator Center (FSC)

Non-specific MCDU hardware

Non-specific hardware switches and indicators can be configured in the ProSimA320 System Combined Configuration, use the search option to find the correct input, ‘MCDU’.

All our offers and agreements are subject to the applicable Terms and Conditions for the ProSim Software for either commercial or non-commercial use. These have been filed with the Chamber of Commerce in The Netherlands under number 54069645.
ProSimA320 MCDU options

Fonts
Font type and size can be adjusted based on own preference. In general the default setting should be used. To reset to the original font size and type select “Reset to default”. Fonts can only be adjusted for video cable connected MCDUs.

Options

Start minimized option is used to automatically minimize the ProSimA320 MCDU on startup. This should not be used for VGA/DVI connected MCDUs.

Start full screen is used when a full screen is required, most VGA/DVI connected MCDUs require a full screen setup to align all line select switches.

The web MCDU is not yet implemented at the time of writing of this manual.
Stay on top is used to keep ProSimA320 MCDU on top on the desktop, even when other programs are running the MCDU will always remain visible.

Hide the mouse cursor option is not implemented yet at time of writing of this manual.

‘Allow remote computer shutdown’ is used to remotely shut the computer down using the IOS.

Show frame is an option to toggle between displaying the complete MCDU or the display only. Showing the display only is used for VGA / DVI connected MCDUs.

Show border is a option to remove the Windows border around the MCDU display. Additional a option “do not move window when border is off” is available to lock the window position.

The use color option by default is on. ProSimA320 MCDU is using multiple colours to identify the function of specific areas in the MCDU.

Doubleclick to resize option can be deselected when a static display is required. When this option is selected and select doubleclick in the MCDU display the display changed to full screen.

Use keyboard leds option is not available yet at the time of writing of this manual.

Screen layout for VGA / DVI connected MCDUs

When using a VGA / DVI connected MCDU it may be required to align the screen display with the Line Select Keys (LSK).

Before opening the line select option first select a MCDU page which contains a lot of information, see example image. To start aligning the different lines open the line select mode (open ProSimA320 MCDU > right mouse click > line select mode).
The first line (LSKR1) should be lighted in a yellow square box. Align the line by using the following commands:

- Up and Down (computer keyboard entry “U” and “D”)
- Left and right (computer keyboard entry “L” and “R”)
- Wides and Shorten (computer keyboard entry “W” and “S”)

When the first line is configure select the next LSK to perform the configuration again, all until all lines are aligned correctly.
ProSimA320 Hardware Connector

The ProSimA320 Hardware Connector module is used to connect USB hardware to secondary computers. At the time of writing of this manual only the FDS and direct input drivers are supported. The ProSimA320 Hardware Connector module may be installed across multiple secondary computers. It should never be installed on the primary computer.

Start the ProSimA320 Hardware connector and open the config page, ProSimA320 HardwareConnector > File > Config.

Enter the IP address of the primary computer.

Restart the ProSimA320 Hardware Connector, select the driver in ProSimA320 on the primary computer and connect the devices. The connected devices are listed in the ProSimA320 System IO overview in the main screen.

No configurations are done in the ProSimA320 Hardware Connector.
ProSimA320 IOS

Introduction

The ProSimA320 IOS (Instructor Operating Station) is used to control the simulator. The IOS has a broad variety of features like weather, reposition, failures and flight parameters.

The ProSimA320 IOS is web based thus can be used on any web capable device in the network supporting HTML5.

ProSimA320 System features a built in web server. In order to access the IOS open the IP address of the primary computer in a web browser using port 8080, for example:

http://192.168.0.0.1:8080
ProSimA320 IOS features

The IOS is using a vertical and horizontal navigation bar. The vertical navigation is used for chapters the horizontal bar is used to navigate within a chapter. The architecture is designed to use the upper part of the vertical navigation during flight, the middle part of the vertical navigation is used to preset the aircraft before the flight and the last part of the vertical navigation is used for monitoring simulator status.

ProSimA320 Flight Model

The ProSimA320 Flight Model is unique and specifically developed for use with ProSimA320. Based on true data, this model performs the most realistic behaviour of aircraft dynamics, with a visual outlook of optional pre designed liveries and the ability to personally customize.

The ProSimA320 Flight Model is compatible with the following back end simulators:
- Microsoft Flight Simulator X
- Microsoft Flight Simulator FS-SE
- Lockheed Martin Prepar3d
  - Version 1.xx
  - Version 2.xx
  - Version 3.xx

It is recommended to create a default flight, this default flight should be saved as ‘default flight’. Before saving the default flight make sure to select an appropriate weight, fuel and trim value. Always use the virtual cockpit and deselect the cockpit view. On default in the simulation platform settings area the G-effect is selected, always deselect this option to have a realistic flight model view.

Please refer to the ProSimA320 Flight Model user manual for more details on the installation and use of the flight model.
Miscellaneous

Automatic startup for ProSimA320 modules

Automatic start of ProSimA320 modules when a computer is started can be achieved by using the Windows startup directory.

- Create a shortcut of the module executable.
- Copy the shortcut
- Open the following directory:
  C:\Users\[UserName]\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup
- Paste the created shortcut in to this directory.

FSUIPC

ProSimA320 System uses FSUIPC inorder to connect to the simulator platform. Install FSUIPC and open the menu under add-ons in your back end simulator.

In the FSUIPC miscellaneous tab the “extended battery life” value should be set to “0” (nul). No other settings should not be used. All hardware devices, including calibration of flight controls, are configured in ProSimA320 System.
Backend simulator settings

The following settings should be done:

- Remove the default cockpit view (0.0) by right mouse clicking on the cockpit panel and select “Close Window”.

- Disable “G-effect” in > World > Realism > Special effects.
- Right click the back end simulator, under cockpit select “virtual cockpit” for the landing lights to work.
- Settings > Controls > Calibration, uncheck the ‘Enable controllers” box.
- Settings > Controls > Buttons and Keys, remove all axes assignments.
- Settings > Controls > Axes, remove all axes assignments.